
Discover Handy Tips to Help You
Manage Your Files More Effectively

For many of us, one of the most-used programs in
Windows is File Explorer (or Windows Explorer as it’s
known in Windows 7). You might press + to start
it, or click its icon on your taskbar, but all sorts of actions
cause an Explorer window to open and show you the
contents of a folder or a drive. 

But are you using File Explorer as effectively as you
could? Read on to pick up some useful tips and tricks to
help you get things done more quickly and easily.

E

19

This article shows you how to:

� Set up File Explorer in the most practical way

� Use clever tricks to select and rename multiple files

� Get things done more quickly from the keyboard
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Ensure File Explorer is Set Up for 
Easiest Use
Applies to: Windows 10, 8.1 & 7

A curiosity of File Explorer is that it isn’t set up in the most
practical way. A couple of settings need changing to make
it more useful and friendly. You may have changed those
settings already, but if you haven’t, you certainly should!

Press + to open File Explorer and we’ll first make
sure you can see the ‘navigation pane’ at the left of the
window, indicated in the screenshot below:

If you can’t see this navigation pane, we need to switch it on:

•  Windows 10 and 8.1: switch to the View tab on the
Ribbon, click the Navigation pane button at the far-left,
then click Navigation pane on the menu that opens.

•  Windows 7: click the Organize button on the blue
toolbar near the top of the window, move the mouse to
Layout and click Navigation pane on the flyout menu.

E
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Check a couple
of settings first

Open File
Explorer

Can you see the
navigation pane?
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Now we’ll turn our attention to the two settings I ment-
ioned a moment ago. The first is an option named ‘Show
all folders’. This transforms the navigation pane from what
you’re probably seeing at the moment – shown on the left
in the screenshot below – to the fuller list shown on the
right. (The screenshot shows Windows 10, but the effect is
similar in Windows 8.1 and Windows 7.).

By doing this, you gain quick access to a few extra places
in File Explorer. You can click on Desktop to see the files
and shortcuts on your desktop; click the folder with your
own name (Rob in my case) to see all your personal folders;
and you also gain one-click access to Control Panel and
Recycle Bin, saving you the need to go elsewhere when you
need to open these items.

The second option we’ll switch on is named ‘Expand to open
folder’. This is best explained with an example, which you

F 214/3
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The ‘Show all
folders’ option

Quick access to
a few extra
folders

The ‘Expand to
open folder’ 

At the moment, that navigation pane may be too narrow
to display the full names of items listed there. To put
that right, move your mouse to the thin line dividing
that pane from the main right-hand section and drag it
further to the right to widen the navigation pane.
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The navigation
pane shows
where you are
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can try yourself. Start by clicking This PC or Computer at
the left of File Explorer. In the right-hand section, double-
click your hard drive’s icon (whose name ends with C: in
brackets), then double-click the Program Files folder, then
double-click the Internet Explorer folder. You’re now looking
at the contents of that ‘Internet Explorer’ folder, but the
navigation pane on the left probably hasn’t changed:

When we switch on this ‘Expand to open folder’ option, the
navigation pane will update to show you constantly where
you are. A glance at that left pane shows you that you’re
currently looking at the Internet Explorer folder , which
is inside the Program Files folder        , which is on your C:
drive     . Usefully, too, if you want to go back to your
Program Files folder, or to some other folder on your C:
drive, you can see it in that left pane and click it to open it.
That’s a great deal quicker and easier than having to do
everything in the right-hand pane.

A
B

C

C

B

A
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So, let’s switch on those two options. Follow the appropriate
steps below for your version of Windows.

Windows 10 and Windows 8.1:

Switch on these
two options

1.  Switch to the View tab on the Ribbon .
2.  Click the Navigation pane button .
3.  On the menu that appears, is there a tick beside Show

all folders ? If there isn’t, click that item to tick
it and switch it on. That also closes the menu, so click
the Navigation pane button again.

4.  Now, is there a tick beside Expand to open folder 
? If there isn’t, click that item to tick it and switch

it on. (If there is, just press the        key on your
keyboard to close the menu.)

2

1

3

4

:

Tick the box
beside both
options

:

Esc

Windows 7:

1.  On the blue toolbar near the top of the window, click
on Organize.

2.  On the menu, click on Folder and search options.
3.  In the Folder Options dialog that appears, you’ll see a
‘Navigation pane’ section at the bottom containing
two checkboxes (pictured on the next page). Tick both
boxes, if they’re not already ticked, and then click OK.

1

2

4

3
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Open Your Personal Folders from the 
Start Menu
Applies to: Windows 10

When you open the Start menu in Windows 10, you see a
column of small icons at the far left: the Power button at
the bottom, Settings above it, and so on. You can also add
icons for your personal folders here – Documents, Pictures,
Music, and others – giving you a quick way to open those
folders. Here’s how:
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Put your
personal folders
a click away

Switch on
folders to
include on the
Start menu

Icons appear at
the far-left of
the Start menu

1.  Open the Start menu and click the Settings (cog-
shaped) icon.

2.  In the Settings window, click on Personalisation and
then, at the left, on Start.

3.  On the right, click the link that reads Choose which
folders appear on Start.

4.  Now you’ll see a list of items, each with an
On/Off switch beneath it. The first two items
– File Explorer and Settings – should be set
to ‘On’. Below those you’ll see the names of
folders such as Documents, Music and
Pictures. If you visit any of these folders
regularly, and you’d like to add it to your
Start menu for one-click access, click the
switch below it to turn it to On.

5.  You can keep the Settings window on your screen while
you open the Start menu to see the result: the extra
folders appear at the far-left of the Start menu. In the
screenshot to the right, I’ve added the Documents,

:
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Quick links to
favourite folders

Add favourite
folders to the
navigation pane

Now, whenever you want to open one of your personal
folders, you can go to the Start menu and click the corres-
ponding icon.

Reach Your Most-used Folders Quickly
Applies to: Windows 10, 8.1 & 7

Just as you can keep a list of your favourite websites in your
web browser (using its Favourites or Bookmarks feature),
you can keep a list of your favourite folders in File Explorer.

As an example, perhaps inside your Documents folder you
have a folder named ‘Family Tree’ where you keep all your
genealogy research. You can get to your Documents folder
fairly quickly and then double-click this folder to open it,
but you’d like an easier way.

The solution is to use the ‘Quick access’ or ‘Favorites’ section
at the very top of File Explorer’s navigation pane. This
section already contains several folders you might visit
regularly, such as ‘Desktop’ and ‘Downloads’, but you can
add others to it for one-click access. Follow the appropriate
steps below to do that:

Windows 10:

    Music and Pictures folders. When you’ve added all
the folders you want, close the Settings window by
clicking the x in its top-right corner.

1.  Open File Explorer and make your way to your
frequently-used folder (in my example, the ‘Family
Tree’ folder).

2.  With that folder open in front of you, switch to the
Home tab on the Ribbon (if necessary), and at the far
left, click the Pin to Quick access button .1

:
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3.  Straight away, you’ll see this folder appear in the
Quick access section at the top of the navigation
pane . (You might have to scroll to the top of the
navigation pane to see this section.)

2

1.  Open File Explorer and make your way to your
frequently-used folder (in my example, the ‘Family
Tree’ folder).

2.  Now you’re probably looking at the contents of that
folder, so you need to go up one level to the folder
containing this one (in my case, the ‘Documents’
folder). An easy way to do that is to press +

on your keyboard.

3.  Now you can see the icon for that frequently-used
folder. Just before you do anything with it, have a

Alt
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Remove
unneeded folders
from the list

In future, whenever you want to visit that folder, you can
click this item. If you ever want to remove this folder from
the Quick access list, just right-click it and choose Unpin
from Quick access.

Windows 8.1 or Windows 7:

:

1

2
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    look at the navigation pane on the left. Can you see
the item at the very top, named Favorites? If not,
scroll to the top of the navigation pane to bring that
item into view.

4.  Next, move the mouse pointer to your frequently-
used folder on the right, press-and-hold the left
mouse button, and then drag it over to the Favorites
item at the top of the navigation pane and drop it
on to that item.

5.  Straight away, you’ll see this folder appear in the
Favorites section. In future, whenever you want to
visit that folder, you can click this item. If you ever
want to remove this folder from the Favorites list,
just right-click it and choose Remove.

Be sure to drop your folder on the Favorites item itself,
and not on one of the folders below it! If you were to
drop it on to the ‘Desktop’ item just beneath it, for
example, you’d move your folder to the desktop, which
would be annoying. 
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Drag and drop a
folder to
‘Favorites’

Remove folders
from this section
if you don’t need
them there

!
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To select, you
normally hold
Ctrl and click

If you drag
accidentally,
copies are made

The easier way:
select files by
ticking boxes
instead
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Select Multiple Files Easily and Safely
Applies to: Windows 10, 8.1 & 7

The usual way of selecting multiple files is to click one file
in the normal way, and then to hold down the key as
you click the others. However, that carries a risk. If you drag
one or more files while holding down the key,
Windows creates copies of them.

Although you’re not intending to drag anything anywhere,
it’s all too easy to do it by accident. You’ve selected several
files, you hold down to select one more, and as you’re
clicking it you move the mouse slightly. You might have
moved it an imperceptible distance, but Windows interprets
it as dragging and makes copies of everything you’ve just
selected.

It’s hard to avoid, especially if your hands are a bit shaky,
but there’s an alternative available. You can tell Windows
to display checkboxes in the top-left corners of every file
and folder. You then select files by simply moving the mouse
over them and ticking their boxes: you don’t hold down the

key, so there’s no risk of making accidental copies.

To switch this feature on, just do the following:

•  Windows 10 or 8.1: switch to the View tab on File
Explorer’s Ribbon and tick the box beside Item check
boxes .

1

2

Ctrl

Ctrl

Ctrl

Ctrl

1 2
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Now move over
a file and tick its
box to select it

Selecting the
majority of files
in a folder?

•  Windows 7: click Organize at the left of the blue toolbar
and choose Folder and search options. In the dialog that
opens, switch to the View tab , scroll to the bottom
of the ‘Advanced settings’ list and tick the box beside Use
check boxes to select items and click OK. 

Now, as you move the mouse over any file, a checkbox will
appear above it or to its left. To select the file, just click
inside the checkbox. (If you select a file by accident, click
its checkbox again to remove the tick.) Helpfully, if you just
want to select a single file, you don’t have to do anything
differently: rather than having to aim for its checkbox, you
can just click its icon in the usual way. 

Select a large number of files in a folder
Here’s a situation you might run into once in a while. You’ve
opened a folder containing a large number of files, and you
want to select the majority of them – not quite all – to delete
them or to copy or move them somewhere.

3

4

3

4
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The traditional approach would be to select them all
carefully, skipping the few you don’t want to select. But
there’s a much quicker and easier way.

Start by selecting the files you don’t want to delete, copy
or move instead – in other words, select the few ‘wrong’
files. When you’ve done that, follow the appropriate step
below for your version of Windows:

•  Windows 10 or Windows 8.1: on the Home tab of the
Ribbon, in the ‘Select’ section at the far-right, click the
Invert selection button. 

•  Windows 7: press the key on your keyboard (just
to the left of the space bar) to display the menu bar,
then open the Edit menu and choose Invert Selection.

What this does is to deselect the few files you just selected
and select all the others – exactly the result you wanted,
but without all that tedious clicking!

Quick Ways to Rename Multiple Files
Applies to: Windows 10, 8.1 & 7

When you want to rename a file or folder on your PC,
there’s a time-honoured way of doing it. You right-click it
and choose Rename from the context menu, which puts the
filename into ‘edit mode’, type the new name to replace the
old and then press the key to confirm it and switch
off ‘edit mode’.

Alt

Enter
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Select the others
instead

Then ‘invert’ the
selection

The files you
wanted are now
selected

The ‘typical’ way
of renaming files
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For a long series
of files, it’s slow

Instead, type the
new name then
press Tab

Ignore the 
way files are
rearranged as
you do this!

Having to right-click and deal with context menus is rather
fiddly, and you can avoid that by clicking the file once to
select it and then pressing the key, which also puts
the filename into ‘edit mode’.

But imagine there’s a whole series of files you want to
rename: this is still going to be a slow process. For example,
perhaps you’ve taken individual photos of everyone at a
family gathering, and you want to replace your camera’s
anonymous filenames (such as DSCN0364, DSCN0365,
DSCN0366…) with the names of the subjects (Lucy, David,
Angela…).

Here’s a quicker and easier way of doing it. Start by click-
ing the first file you want to rename, pressing to put
its filename into ‘edit mode’ and typing the new name.
However, when you’ve done that, don’t press . Inst-
ead, press the Tab key. In one neat manoeuvre, this confirms
the new name of that file and takes it out of ‘edit mode’,
and then selects the next file in the folder and puts that into
‘edit mode’, letting you immediately start typing that name.
Press again after doing so and you’re inst-antly ready
to type the name of the next file, and so on.

Two quick tips to accompany this. First, if you land on a
file you don’t want to rename, just press Tab again to leave
its name unchanged and move to the next. Second,
assuming your files are arranged alphabetically (as they
probably are), they’ll tend to jump around as you change
their names, since Windows keeps them alphabetical, but
ignore that and just keep going!

F2

F2

Enter

Tab

WA6 F214.qxp_June 2020  22/04/2020  15:18  Page 31



Rename files in a numerical sequence
Here’s a quick tip that’s useful for renaming collections of
digital photos. When you import them from your camera or
phone, they have anonymous names like this:

You’d like to give them better, more meaningful names, but
that could be a slow and laborious job, even using the tip
above. But File Explorer offers a quick way of renaming a
sequence of files in one quick routine.

Start by selecting all the files you want to rename. Then
right-click the first selected file and choose Rename. This
puts that first file’s name into ‘edit mode’. Type the name
you’d like to give to all these files:

Press the key and File Explorer completes the job for
you: all your selected files are renamed with the name you
chose followed by a number in brackets:

Enter
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Photos have
anonymous
names

Rename them 
all quickly

File Explorer
creates a
sequence

WA6 F214.qxp_June 2020  22/04/2020  15:18  Page 32



File Explorer Tips & Tricks     F 214/15

The Windows Advisor   June 2020 33

Manage Your Files Faster Using 
Keyboard Shortcuts
Applies to: Windows 10, 8.1 & 7

Some of what you do in File Explorer is best accomplished
using the mouse. However, certain things need a sequence
of two or three clicks, or a fiddly right-click, and you can
do many of those more quickly by pressing a single key or
a key combination. Here are the most useful keyboard
shortcuts to use in File Explorer:

Work faster from
the keyboard

To do this: Use this hotkey:

Open File Explorer Win+E

Open a second File Explorer window Ctrl+N

Open the selected drive, folder or file Enter

Select all items in the current 
drive or folder

Ctrl+A

Display Properties (information) dialog
for the selected drive, folder or file

Alt+Enter

Rename the selected drive, folder or file F2

Delete the selected item(s) to the 
Recycle Bin

Delete

Permanently delete the selected item(s),
bypassing the Recycle Bin

Shift+Delete

Search the current drive or folder F3

Create a new folder in the current drive
or folder

Ctrl+Shift+N

Jump to the first item in the folder Home

Jump to the last item in the folder End

Jump to the first (or next) item whose
name starts with a certain letter

Type the first
letter of its name
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Step back to the last-viewed drive
or folder

Backspace or
Alt+Left arrow

Step forward again after stepping back Alt+Right arrow

Go up to the parent folder of the
current folder

Alt+Up arrow

View as Extra large icons 
(Win 10 & 8.1)

Ctrl+Shift+1

View as Large icons (Win 10 & 8.1) Ctrl+Shift+2

View as Medium icons (Win 10 & 8.1) Ctrl+Shift+3

View as Small icons (Win 10 & 8.1) Ctrl+Shift+4

View as a List (Win 10 & 8.1) Ctrl+Shift+5

View as Details (Win 10 & 8.1) Ctrl+Shift+6

View as Tiles (Win 10 & 8.1) Ctrl+Shift+7

View as Content (Win 10 & 8.1) Ctrl+Shift+8

Show or hide the Preview pane Alt+P

Show or hide the Details pane 
(Wins 10 & 8.1)

Shift+Alt+P

Show the menu bar (Win 7) F10

Show the context menu for the 
selected item(s)

Shift+F10

Undo the last change you made 
(delete, copy, move or rename)

Ctrl+Z

Copy the selected item(s) to the
clipboard (to copy them elsewhere)

Ctrl+C

Cut the selected item(s) to the clipboard
(to move them elsewhere)

Ctrl+X

Paste the cut or copied items into the
current drive or folder

Ctrl+V
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